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Creating a Project 
  

Steps to Create a WebAccess Project 

 



 Six Phases to Complete a WebAccess Project: 

 

Phase 1: Project Home (Link WebAccess to the Hardware) 
– Step 1: Create a Project Node 

– Step 2: Create a SCADA Node 

– Step 3: Create a Communication Port 

– Step 4: Determine Device Type 

– Step 5: Create IO Tags  

 

Phase 2: Download Project to SCADA Node 

 

Phase 3: Draw / DrawDAQ (Creating Graphic User Interface (GUI)) 

                    

Phase 4: Download Draw / DrawDAQ to SCADA Node 

 

Phase 5: Start Kernel (Run at SCADA Node) 

 

Phase 6: View / ViewDAQ (Graphic Display) 

 

 

Six Phases 



Phase 1 Detail 

SCADA Node_1 SCADA Node_2 

ADAM-4K ADAM-6K 

(LAN Port) 

(LAN Port) 

(COM Port) 

(COM Port) 

TCP/IP Serial 

Project Node 

Tag point: 
DI/DO/AI/AO 

Tag point: 
DI/DO/AI/AO 

Step 1. Create a Project Node 

Step 2. Create a SCADA Node 

Step 3. Determine Communication Port 

Step 4. Determine Device Type 

Step 5. Create Tags/Assign Tag Addresses 

– Create a Project Name 

– Assign Project Node IP Address 

 

 

– Connecting to all kind of Automation Devices 

– Create a SCADA Node Name 

– Assign SCSDA Node IP Address 

 

DO DI AO AI 

– Example: ADAM-4K Series (COM Port) => Serial 

– Example: ADAM-6K Series (LAN Port) => TCP/IP 

 

 

– Determines the communication Protocol used by WebAccess 

– Example, Modbus RTU, Modbus Ethernet, Or Other Proprietary 

Protocol etc… 

 

 

– Create and assign tag address according to physical 

DI/DO/AI/AO point of Automation Device. 

– Each “Tag” is an unique identifier 

 

 

 



 WebAccess has two types of Tag: 

 Hardware Tag (connect to hardware) 

 Software Tag (NOT read hardware IO directly) 

 Constant Tag 

 Accumulation Tag 

 Calculation Tag 

 System Tag 

 

 

Tag Introduction 
- Hardware Tag- 



Phase 1:  
 

Project Home 
  

(Link WebAccess to the Hardware) 
 



SCADA Node_1 SCADA Node_2 

ADAM-4K ADAM-6K 

(LAN Port) 

(LAN Port) 

(COM Port) 

(COM Port) 

TCP/IP Serial 

Project Node 

Tag point: 
DI/DO/AI/AO 

Tag point: 
DI/DO/AI/AO 

Step 1. Create a Project Node 

Step 2. Create a SCADA Node 

Step 3. Determine Communication Port 

Step 4. Determine Device Type 

Step 5. Create Tags/Assign Tag Addresses 

– Create a Project Name 

– Assign Project Node IP Address 

 

 

– Connecting to all kind of Automation Devices 

– Create a SCADA Node Name 

– Assign SCSDA Node IP Address 

 

DO DI AO AI 

– Example: ADAM-4K Series (COM Port) => Serial 

– Example: ADAM-6K Series (LAN Port) => TCP/IP 

 

 

– Determines the communication Protocol used by WebAccess 

– Example, Modbus RTU, Modbus Ethernet, Or Other Proprietary 

Protocol etc… 

 

 

– Create and assign tag address according to physical 

DI/DO/AI/AO point of Automation Device. 

– Each “Tag” is an unique identifier 

 

 

 

Phase 1: Project Home 



 After finishing WebAccess installation and rebooting the computer, there 

will be a small computer icon        appears in the right bottom side of the 

screen. 

 Move mouse cursor over the computer icon, it will show WebAccess 

version and released date. 

Phase 1: Project Home 



 Move mouse cursor over the WebAccess icon and clicking left 

button of mouse. Select “Project Home” 

 Clicking “Project Management” 

Phase 1: Project Home 



 User name is “Admin” and there is no password in default setup. 

 Directly click “Login” button to log into the WebAccess 

Phase 1: Project Home 



 Enter Project Name (ex. Training) and IP Address(127.0.0.1) 

 Either IP Address or Computer Name is allowed in Project Name 

 Click “Submit for New Project” after entering Project Name and IP Address 

Phase 1 - Step 1: 
Creating a Project Node 



 After clicking “Submit for New Project” button, a confirmation dialog box 

will pop out.  

 Click “Yes” to create the project 

Phase 1 - Step 1: 
Creating a Project Node 



SCADA Node_1 SCADA Node_2 

ADAM-4K ADAM-6K 

(LAN Port) 

(LAN Port) 

(COM Port) 

(COM Port) 

TCP/IP Serial 

Project Node 

Tag point: 
DI/DO/AI/AO 

Tag point: 
DI/DO/AI/AO 

Step 1. Create a Project Node 

Step 2. Create a SCADA Node 

Step 3. Determine Communication Port 

Step 4. Determine Device Type 

Step 5. Create Tags/Assign Tag Addresses 

– Create a Project Name 

– Assign Project Node IP Address 

 

 

– Connecting to all kind of Automation Devices 

– Create a SCADA Node Name 

– Assign SCSDA Node IP Address 

 

DO DI AO AI 

– Example: ADAM-4K Series (COM Port) => Serial 

– Example: ADAM-6K Series (LAN Port) => TCP/IP 

 

 

– Determines the communication Protocol used by WebAccess 

– Example, Modbus RTU, Modbus Ethernet, Or Other Proprietary 

Protocol etc… 

 

 

– Create and assign tag address according to physical 

DI/DO/AI/AO point of Automation Device. 

– Each “Tag” is an unique identifier 

 

 

 

Phase 1: Project Home 



 The Project Node is created. 

 Click “Training” to create a SCADA Node 

Phase 1 - Step 2: 
Creating a SCADA Node 



 Click “Add SCADA Node” 

Phase 1 - Step 2: 
Creating a SCADA Node 



 Node Type: Professional Version (depend on your computer) 

 Node Name (ex. 20091215) and IP Address (ex. 127.0.0.1) 

Phase 1 - Step 2: 
Creating a SCADA Node 



 Select “Tagname” in Trend Hairline Tooltip 

 Click “Yes” in toolbar Tooltip 

 Click “Submit” 

Phase 1 - Step 2: 
Creating a SCADA Node 



SCADA Node_1 SCADA Node_2 

ADAM-4K ADAM-6K 

(LAN Port) 

(LAN Port) 

(COM Port) 

(COM Port) 

TCP/IP Serial 

Project Node 

Tag point: 
DI/DO/AI/AO 

Tag point: 
DI/DO/AI/AO 

Step 1. Create a Project Node 

Step 2. Create a SCADA Node 

Step 3. Determine Communication Port 

Step 4. Determine Device Type 

Step 5. Create Tags/Assign Tag Addresses 

– Create a Project Name 

– Assign Project Node IP Address 

 

 

– Connecting to all kind of Automation Devices 

– Create a SCADA Node Name 

– Assign SCSDA Node IP Address 

 

DO DI AO AI 

– Example: ADAM-4K Series (COM Port) => Serial 

– Example: ADAM-6K Series (LAN Port) => TCP/IP 

 

 

– Determines the communication Protocol used by WebAccess 

– Example, Modbus RTU, Modbus Ethernet, Or Other Proprietary 

Protocol etc… 

 

 

– Create and assign tag address according to physical 

DI/DO/AI/AO point of Automation Device. 

– Each “Tag” is an unique identifier 

 

 

 

Phase 1: Project Home 



 SCADA Node is created; click “Add Comport” 

 Select “TCPIP” in Interface Name, then click “Submit” 

Phase 1 - Step 3: 
Determine a Comm Port 



SCADA Node_1 SCADA Node_2 

ADAM-4K ADAM-6K 

(LAN Port) 

(LAN Port) 

(COM Port) 

(COM Port) 

TCP/IP Serial 

Project Node 

Tag point: 
DI/DO/AI/AO 

Tag point: 
DI/DO/AI/AO 

Step 1. Create a Project Node 

Step 2. Create a SCADA Node 

Step 3. Determine Communication Port 

Step 4. Determine Device Type 

Step 5. Create Tags/Assign Tag Addresses 

– Create a Project Name 

– Assign Project Node IP Address 

 

 

– Connecting to all kind of Automation Devices 

– Create a SCADA Node Name 

– Assign SCSDA Node IP Address 

 

DO DI AO AI 

– Example: ADAM-4K Series (COM Port) => Serial 

– Example: ADAM-6K Series (LAN Port) => TCP/IP 

 

 

– Determines the communication Protocol used by WebAccess 

– Example, Modbus RTU, Modbus Ethernet, Or Other Proprietary 

Protocol etc… 

 

 

– Create and assign tag address according to physical 

DI/DO/AI/AO point of Automation Device. 

– Each “Tag” is an unique identifier 

 

 

 

Phase 1: Project Home 



 Click “Port1”, then click “Add Device” 

Phase 1 - Step 4: 
Determine a Device Type 



 Device Type: Modicon 

 Device Name: modbusTCP (any name user wants to enter) 

 Unit Number: 1 

 IP Address: 127.0.0.1 

 Port Number: 502 (based on ModSim32 setup) 

 Device Address: 1 

 After entering the above info, click “Submit” button 

Phase 1 - Step 4: 
Determine a Communication Port 



SCADA Node_1 SCADA Node_2 

ADAM-4K ADAM-6K 

(LAN Port) 

(LAN Port) 

(COM Port) 

(COM Port) 

TCP/IP Serial 

Project Node 

Tag point: 
DI/DO/AI/AO 

Tag point: 
DI/DO/AI/AO 

Step 1. Create a Project Node 

Step 2. Create a SCADA Node 

Step 3. Determine Communication Port 

Step 4. Determine Device Type 

Step 5. Create Tags/Assign Tag Addresses 

– Create a Project Name 

– Assign Project Node IP Address 

 

 

– Connecting to all kind of Automation Devices 

– Create a SCADA Node Name 

– Assign SCSDA Node IP Address 

 

DO DI AO AI 

– Example: ADAM-4K Series (COM Port) => Serial 

– Example: ADAM-6K Series (LAN Port) => TCP/IP 

 

 

– Determines the communication Protocol used by WebAccess 

– Example, Modbus RTU, Modbus Ethernet, Or Other Proprietary 

Protocol etc… 

 

 

– Create and assign tag address according to physical 

DI/DO/AI/AO point of Automation Device. 

– Each “Tag” is an unique identifier 

 

 

 

Phase 1: Project Home 



 modbusTCP device will be created, then click “Add Tag” 

 We have to create one DI tag to get Modbus DI value. 

 The following three fields must be filled.  

 Parameter: DI; Tag Name: DI0; Address 10001 
Click “submit” after entering all necessary info 

Phase 1 - Step 5: 
Create Tags / Assign Tag Addresses 



 The created tag will show on the right hand side. 

 After SCADA Node and tag are created, we have to download them to the 

SCADA Node computer. In this practice, Project Node and SCADA node are 

in the same computer (IP Address: 127.0.0.1) 

Phase 1 - Step 5: 
Create Tags / Assign Tag Addresses 



Phase 2:  
 

Download Project to SCADA Node 
 
 



 Click SCADA Node (20091215) and click “Download” 

 In the Download dialog box, click “Submit” button 

Phase 2:  
Download Project to SCADA Node 



 Once the Download process is done, the Done dialog box will pop out. 

Simply click “Close Window” button to finish the process. 

Phase 2:  
Download Project to SCADA Node 



Phase 3:  
 

Draw / DrawDAQ 
 

(Creating GUI) 
 



 Now we start to create Graphic User Interface (GUI) 

 Move mouse cursor to the computer icon, then click the right button of the 

mouse. 

 DrawDAQ -> Training_20091215 

Phase 3:  
Draw / DrawDAQ 



 Click “ABC” button to create a text 

 Type any three character (ex. xxx) on the blue screen, and then click “Enter”. 

The characters (xxx) will be highlighted. 

text 

Phase 3:  
Draw / DrawDAQ 



 Click “Dynamic” -> “Animation” -> “Animation Configuration” dialog box 

will appear. In tag box, select “DI0” and select “C-text” 

Still in highlight 

condition 

Dynamic 

C-Text means to put 

text in the center of the 

TEXT field 

Phase 3:  
Draw / DrawDAQ 



 Now, let’s use “Pie” function to draw a circle. 

Pie 

Phase 3:  
Draw / DrawDAQ 



 Click “Dynamic” -> “Animation” -> “Animation Configuration” dialog box 

will appear. In tag box, select “DI0” and select “Color” 

 Because DI0 is DI tag, in “Digital Status”, we can modify IO ON and OFF 

colors. Last, click OK to save to setup. 

Dynamic 

color 

Phase 3:  
Draw / DrawDAQ 



 Click “save BGR” button to save the file. 

Save BGR 

Note: 

Let’s save the file as 

Main.bgr because when 

run View or ViewDAQ, 

WebAccess will start 

with the main.bgr page. 

Select “Entire Drawing” 

Save as “main.bgr” 

Put check mark on 

“Save DRW file” 

After click “OK” on “Save BGR file”, “Save DRW File” 

dialog box will pop out. Changing the file name to 

“main.drw” 

Phase 3:  
Draw / DrawDAQ 



Phase 4:  
 

Download Draw / DrawDAQ to 
SCADA Node 

 



 Download the DAQ to SCADA Node 

 Download Graph -> Training_20091215 

Phase 4:  
Download Draw / DrawDAQ 



Phase 5:  
 

Start Kernel 
  

(Run at SCADA Node) 
 



 After download is completed, let’s start the Kernel 

 Start Kernel -> Training_20091215 

Phase 5:  
Start Kernel 

 After the Kernel starts, the computer icon color will turn to green. 

 Move the mouse cursor over the computer icon, it will show current running 

Project Node and SCADA Node names. 



Phase 6:  
 

View / ViewDAQ 
  

(Graph Display) 
 



 Select “ViewDAQ” to view the result. 

Phase 6:  
View / ViewDAQ 

 Default Welcome Page will pop out. 

 Click on the screen to enter main.bgr page 

Note 

 

 Before clicking to enter main.bgr page, 

please active ModSim (modbus 

simulation) 

 The next topic, ModSim, teaches user 

how to active ModSim  



 In ModSim32, when Modbus address (10001) value is 1, WebAccess will 

display “ON” text with red circle. 

Phase 6:  
View / ViewDAQ 

 In ModSim32, when Modbus address (10001) value is 0, WebAccess will 

display “OFF” text with green circle. 



 If user doesn’t read other symbol displays on the screen install of tag value 

 Three possibilities: 

Phase 6:  
View / ViewDAQ 

Symbol Meaning Possible Solutions 

1 * The communication fails Check comport, device 

and tag setup 

2 # The tag doesn’t exist - Check whether user 

deletes this tag 

- Re-download the 

project again 

3 ! The tag value length is too large 

to fit in the field size for the tag 

Go to tag property and 

modify display digits for 

both integer and fraction 



ModSim 
 

Modbus Simulation 
 



 Because this example is using WebAccess to read Modbus DI value, user 

has to run ModSim32 in order to simulate Modbus DI value. 

 ModSim32 trial version can be downloaded from the following website: 

– http://www.win-tech.com 

ModSim32 
- Modbus Simulator - 



 File -> New 

 Connection -> Connect -> Modbux/TCP Svr 

 

 Then, a dialog box pop out. Set Modbus/TCP Service Port number to 502 

 

ModSim32 
- Modbus Simulator - 



 Because we simulate DI value, so we use do the following setup. 

 MODBUS Point Type: 02:INPUT STATUS 

 Address: 0001 

 Length: 10 

  
 Double click on and a <0> “Write Coil” dialog box will pop out. 

  

ModSim32 
- Modbus Simulator - 



 Click “Auto Simulation” button and “Coil Simulation” dialog box will pop 

out. 

 Click “Enabled” and click “OK” button. 

“Change Interval 

(secs)” means its 

value will be changed 

in every 5 seconds. 

ModSim32 
- Modbus Simulator - 



Software Tag 
 



 WebAccess has two types of Tag: 

 Physical Tag (connect to hardware) 

 Software Tag (NOT read hardware IO directly) 

 Constant Tag 

 Accumulation Tag 

 Calculation Tag 

 System Tag 

• Quantity of software tag: Number of software tag is equal to number of 

physical tag. Eg. When user purchase 75 physical tag license, he will also 

have 75 software tags. 

Tag Introduction 
- Software Tag - 



 Back to the SCADA Node, and click “ConstPoint” 

 Click “Add Const Point” 

Software Tag 



 Selece “ConAna” in Parameter. Setup  Tag name as “A0”  

 Setup Span High and Output High Limit values to 1000 

Last, click “Submit” button 

to complete creating tag 

procedure. 

Software Tag 



 Follow the last slider to create another constant tag which named it as A1 

Software Tag 



 After create two constant tags, let’s create a calculate tag (CalcPoint) 

Software Tag 



 Tag Name: calculate 

 Span High: 2000; Output High Limit: 2000 

Software Tag 



 Move to Formula 

 In Formula box, fill in “A+B” 

 In A field, enter “A0” constant tag name 

 In B field, enter “A1” constant tag name 

Software Tag 



 Back to the SCADA Node and click “Download” 

Click “20091215” will 

back to SCADA Node 

Setup page 

After download 

process completes, 

select DrawDAQ -> 

Training_20091215 

Software Tag 



 Click “OpenDrw” and select “main.drw” 

OpenDRW 

main.drw 

Software Tag 



Widget 1. 

2. 

 Click on “Widget” button and select $Slider02.dwt 

 Then “Tag List” dialog box will pop out, select A0 

3. 

Software Tag 



 Repeat last slider about Widget steps, this time, user has to select A1 in 

“Tag List” 

$Slider02 bundle with A0 

$Slider02 bundle with A1 

Software Tag 



 Use “ABC” text box to put “+” and “=“ symbols on the screen. 

 Use “ABC” text box again to write 7 “x” and highlight it. 

“ABC” Text button 

Software Tag 



 After 7 “x” types on the screen, click “Enter” button and xxxxxxx will be 

highlighted. 

 Dynamic -> Animation; Select “calculate” in Tag field and select “L-Text” 

 

Highlight condition 

Tag name can be selected from the right hand side 

Software Tag 



 Save BGR 

 Download Graph -> Training_20091215 

 If Kernel doesn’t start, then start the Kernel 

 Run ViewDAQ and user will be able to see the slider bars with values. 

 

Software Tag 



Realtime Trend 
 



 Click “SCADA Node” and then click “RealTimeTrend” 

 

Realtime Trend 



 Click “Add RealTime Trend” 

 

Realtime Trend 



 Add “A0” and “A1” to Tag Name 

 Remember to setup both “Display High #” and “Display Low 3” 

 Last, click “Submit” button 

 

Realtime Trend 



 Click “Download” 

 

Realtime Trend 



 Click “Readtime Trend” button 

Realtime Trend 



 Select “Group Number” and user will able to see the RealTime Trend. 

 

Realtime Trend 



DataLog Trend 
 

(Historical Trend) 
 



 By setting Log Data for DataLog Trend, LogData Maintenance must also 

setup 

 Data Maintenance supports data relocation save and deletion 

 These actions will make sure the database won’t explore 

 

DataLog Trend 

data maintenance starts time 

Save data to other location Delete expired data 



 In Tag property, “Log Data” must set as “Yes” in all tag. 

 Let’s select “AO” tag 

 

DataLog Trend 



 Click “SCADA Node” and then click “DataLogTrend” 

 

DataLog Trend 



 Click “Add Datalog Trend” 

 

DataLog Trend 



 Add “A0” and “A1” to Tag Name 

 Remember to setup both “Display High #” and “Display Low 3” 

 Last, click “Submit” button 

DataLog Trend 



 Click “Download” 

 

DataLog Trend 



 Click “Datalog Trend” button in ViewDAQ 

 

DataLog Trend 



 Select “Group Number” and user will able to see the Datalog Trend. 

 

DataLog Trend 



 Trend data will be stored at 

 drive:\webaccess\node\Training_20091215\log 

 

DataLog Trend 

 Data is stored based on tag name 

 



Alarm 
 



 Click “A0” in ConstPoint, then click “Tag Property” 

 

Alarm 



 Click on “Alarm” and change its setting from “No Alarm” to “Alarm” 

 

Alarm 



 An alarm setup will appear in the bottom of the page 

 There are four type of alarm: High High (HH), High, Low, and Low Low (LL) 

 In HH/High/Low/LL priorities, the default setup “0” means “NOT ACTIVE” 

 Setup “HH Priority” to “1” and setup “HH Alarm Limit” to “500” 

 It means if A0 value equals or higher than 500, the alarm will be triggered. 

 Last, click “submit” in the end of page to complete the process 

 

Alarm 



 Also active the constant point A1 alarm. 

 This time, setup “HH Alarm Limit” value to 800 

 Click “submit” to complete the setup 

 

 

Alarm 



 Click SCADA Node and click “Download” 

 

Alarm 



 Turn on ViewDAQ 

 If A0 value equals or over 500, the alarm will be triggered. 

 If A1 value equals or over 800, the alarm will be triggered. 

 

 

Alarms are triggered 

Alarm 



 Click “Alarm summary” will be able to view all alarm details 

Alarm 



 Click “Acknowledge Screen” can acknowledge the alarm, but the A0 and A1 

values are still marked in red. 

 

Alarm 



 If A0 and A1 values are lower than alarm triggered value, the value will color 

will be back to green. 

 Note. Red and green colour are default color, user is freely to change all 

these colors in DrawDAQ. 

 

Alarm 



Alarm Group 
 



 Click on SCADA Node (20091215) -> AlarmGroup 

 Click on “Add Alarm Group” 

Alarm Group 



 In Group Number 1, enter A0 in Tag Name 1, and A1 in Tag Name 2. 

 Click “Submit” button 

 Click “Add Alarm Group” to add another alarm group 

Alarm Group 



 In Group Number 2, only enter A0 to Tag Name 1, then click “Submit” button 

 Click “Download” 

Alarm Group 



 In ViewDAQ, click “Alarm Group” button and select a Alarm Group to monitor 

Alarm Group 



 If user selects Alarm Group 1, then this is how it looks like. 

Alarm Group 



Recipe 
 



 Click “Recipe” in SCADA Node 

 

 Click “Add Recipe File” 

 

Recipe 



 Unit Number: a group of tags 

 Recipe: a group of preset values 

 

Recipe 



 Enter “Recipe File Name” as “R1” 

 Enter “Unit Name” as “unit1” and enter “Recipe Name” as “recipe1” 

 Enter the “Item Name”, “Tag Name” and “Preset Value” 

 

Recipe 



 Click “Submit” button 

 The list boxes will appear beside the Unit Name and Recipe Name. 

 

Recipe 



 Enter “recipe2” in Recipe Name 

 Enter the new value in Preset Value 

 Click “Submit” button 

 

Recipe 



 As the below image, there will be “recipe1” and “recipe2” selections. 

 Once user selects different recipe#, the preset value will be changed 

automatically. 

 

Recipe 



 Back to SCADA Node (20091215) -> Recipe 

 Click “download” 

 

Recipe 



 In ViewDAQ, click “Recipe” button 

 Select “Unit Name” and “Recipe Name”, then click “OK” button 

 

Recipe 



 Click “Download”, a “Download Recipe”dialog box will appear. 

 Click “Download” button, the “CURRENT VALUE” values will be modified to 

“PRESET VALUE” values 

 

Recipe 



 After clicking “download” button, the A0 and A1 values will be changed. 

 

Recipe 



Scheduler 
 



 Go to SCADA Node (20091215), and then click “Scheduler” 

 

Scheduler 



 There are four sections to setup: Holiday, Time, Equipment and Circuit 

Group. Please do it one by one. First, select “Holiday” 

 Setup working day (scheduler will work) and non-working (scheduler will 

NOT work) day. The date with RED COLOUR means non-working day. 

 Last, click “Save and Download SCADA Node” 

 

Scheduler 



 In “Time” section, setup when (Mon ~ Holiday) and what time (start time ~ stop time) to start scheduler. 

 Cycle On means to active this tag for a period of time (unit: minute) 

 Cycle Off means to inactive this tag for a period of time (unit: minute) 

 “0” in both Cycle On and Cycle Off means inactive this action. 

 Cycle On = 1; Cycle Off = 1; This means to active for one minute, then inactive for one minute. 

 Last, click “Save and Download to SCADA Node” 

 

Scheduler 



 In Equipment section, simply click “Save and Download to SCADA Node” 

 

Scheduler 



 In “Circuit Group”, setup Tag Name, On Value and Off Value. 

 In this example, it means on every Wednesday 8:00 to 24:00, A0 will be at On 

Value (300) for one minute, then switch to Off Value (0) for next one minute. 

This action will continue from 8:00 to 24:00. 

 Last, click “Save and Download to SCADA Node” 

 

Scheduler 



 In ViewDAQ, user will see the A0 and A1 values change in every 0 second 

sharp. 

 

0 second sharp 

Scheduler 



Background 
 



 All background images must MANUALLY copy to  

 c:\WebAccess\Node\config\Training_20091215\bmp 

 Copy a jpg or bmp file to c:\WebAccess\Node\config\Training_20091215\bmp 

 In this exercise, we use A-AH2-1Eng.jpg as an example 

 User may also use another image as the background 

 

Background 



 Let’s create a new page. 

 The purpose of creating a new page is that we will create two buttons to 

switch between main and second pages in next hands-on exercise. 

 

Background 



 In DrawDAQ, click “Set Graph Parameter” button. 

 A “Graph Parameters” dialog box will pop out. 

 

Background 



 Click “Background Image File”, and select A.Ah2-1-Eng.jpg 

 Click “On” and user will be able to see the background image. 

 

Background 



 click “Set Graph Parameter” button again, this time un-click the “On” button. 

 The background image will be hidden. 

 

Background 



 Use ABC button         to type “back to main” text, then save as “second.bgr” 

 

Background 



Push Button and Macro 
 



 Use “Open DRW” button            to open second.bgr page 

 DrawDAQ -> Dynamic -> Push Button 

 

Push Button and Macro 



 A “Push Button” dialog box pop out. 

 Find “<GOTO>GRAPH=“ in Marco and put it in “Button Down” 

 Then type “main.bgr” by yourself, then click “OK” button to complete it. 

 

Push Button and Macro 



 Then use mouse to drag a button out. 

Push Button and Macro 



 Move mouse curser to the center of the button, a hand image will appear, 

then click it. 

 
Middle of  the button 

1. Don’t click in Group Objects 

2. Bevel Size setup to 0 

3. Click on Transparent 

4. Don’t’ click “Highlight” 

5. Don’t’ click “Animation”  

Push Button and Macro 



 This will be an invisible button. Invisible button will not affect the 

background image. Remember to save the file. 

 

Push Button and Macro 



 Open Main.bgr 

 Using ABC button          to type “second” string, then click “Enter”. 

 The word “second” will be highlighted. 

 

Push Button and Macro 



 Dynamic -> Push Button 

 In Button Down, enter “<GOTO>GRAPH=second.bgr 

 Last, click “OK” button 

 

1. Click the Group Objects 

2. Set Bevel Size setup to 3 

3. Don’t click on Transparent 

4. Click “Highlight” 

5. Click “Animation”  

Push Button and Macro 



 A button will be created. 

 The button size is based on the length of the text. 

 Note: remember to save the page. 

 

Push Button and Macro 



 Download the project 

– Download Graph -> Training_20091215 

 

Push Button and Macro 



 Run ViewDAQ 

 

User is able to 

switch page by 

clicking the 

buttons 

Push Button and Macro 



 User may have a button that the button size is larger than the length of text 

 Type “second” and draw a button.  

 Remember DO NOT click the “Group Objects” 

 

DO NOT click the 

“Group Objects 

Push Button and Macro 



 Move “second” over the button, then highlight both “second” and the 

button 

 Click the right button of the mouse, then click the “Group” 

 

Push Button and Macro 



 Save the main page and download the project. 

 Two buttons will do the same action. 

Push Button and Macro 



Frame 
 



 Use Constant Point to create a digital tag named “switch” 

 Setup “State 0” to display the word “OFF” 

 Setup “State 1” to display the word “ON” 

 

Frame 



 Go to SCADA Node and click the download. 

 Reopen the DrawDAQ page so the “switch” tag will be seen 

 In a new page, we have to insert the two switch button images 

 Draw -> Bitmap 

 

Use *.* to find both switch 

images and insert on DrawDAQ. 

Frame 



 Display both images on the DrawDAQ, then save this page as temp.bgr 

 

Frame 



 Highlight the 45 degree switch image 

 File -> Save DFM 

 

 Save File name as 45.dfm 

 Select “Selected Objects” 

 

Frame 



 Highlight the 135 degree switch image 

 File -> Save DFM 

 

 Save File name as 135.dfm 

 Select “Selected Objects” 

 

Frame 



 Dynamic -> Animation 

 Click “Frame” and a Frame State” dialog box pop out 

 User should be able to see both 45.dfm and 135.drm 

 

 

Frame 



 Open the second.bgr page 

 Use “rectangle” button to draw & highlight a small rectangle under ON/OFF place 

Rectangle button 

ON/OFF 

Frame 



 Dynamic -> Animation -> Frame -> Digital States 

 Tag name selects “switch” 

 In Digital 0 inserts 135.dfm; in Digital 1 inserts 45.dfm; then click “OK” button to 

complete the steps. 

 Note: the result can only be viewed in View / ViewDAQ 

Frame 



 Draw a button which named “reverse” 

 In Button Down action, enter “<SETVAL>switch=%REVERSE” 

 note: % REVERSE function will switch digital tag value between 0 and 1 

 note: %REVERSE function can’t be found in DaqTag 

Frame 



 Save the file and download the project 

 By clicking the “reverse” button, the switch will change its images continuously. 

 

Frame 



Script - TCLScript 
 



 Open Main.bgr in ViewDAQ 

 Create a button to reverse “switch” digital tag value 

Script - TCLScript 



 Click “Set Graph Parameter” button, and a Graph Parameters dialog box 

popup. 

 

Set Graph Parameter 

Script - TCLScript 



 Click the text box beside “While Showing” 

 Enter the Script program Name. In here, we name it as “changeValue” 

 Last, click “Edit” botton 

Script - TCLScript 



 In TclScript language, code the following 

 “if” can be found by clicking “Keyword” button 

 “GETVAL” and “SETVAL” can be found by clicking “Action” button 

 “==“ and “=“can be found by clicking “Operator” button 

 “switch” constant tag can be found by clicking “I/O Tag” button 

 Last, click “Save” button to save the program 

Script - TCLScript 



 Clicking “OK” button in Graph Parameters dialog box, and save main.bgr 

page. 

 Download the project and run ViewDAQ 

 A0 value will be changed everytime user clicks “switch” button 

Script - TCLScript 



Video Display 
 

- Display Web Page in Video Display - 
 

- Display bgr Page in Video Display - 
 

- Display Flash (*.swf) in Video Display - 
 
 
 
 



1. Right Click the Mouse on DrawDAQ and select the project  

 

 

 

 

 

 

 

 

 

2. Dynamic -> Video Display   

3. Enter a Name and enter the htm: with the IP address or URL of the Web Page. 

 

 

 

 

 

 

4. Select OK . 

Video Display 
- Web Page - 



5. Click once to define the start of a rectangle  

6. Drag with the mouse to define the size of the Video Window in the Graphic. 

7. Click a second time to define the end of the rectangle. 

 

 

 

 

 

 

 

 

 

 

 

 

 

8. Result 

Video Display 
- Web Page - 



daq:graph=image.bgr#user=admin&tool=0&capt=0&stat=0 

Video Display 
- bgr Page - 



Using Button to Switch Bgr Pages 

Switch 

Page 

<SENDPTZ>information=DAQ#<GOTO>GRAPH=temp.bgr 

or 

<SENDVDO>information=daq:graph=temp.bgr 

Realtime 

Trend 

<SENDPTZ>information=DAQ#<GOTO>REALTRD=1 

 

Historical 

Trend 

<SENDPTZ>information=DAQ#<GOTO>DLOGTRD=1 

 

Schedule <SENDPTZ>information=DAQ#<GOTO>TOOL=BWSCH.UTI 

Alarm 

Summary 

<SENDPTZ>information=daq#<GOTO>ALMSUMMARY 

Alarm 

Group 

<SENDPTZ>information=daq#<GOTO>ALMGROUP=1 

Exit <ALT_F4> 

Video Display 
- bgr Page - 



1. Copy flash file (*.swf) to webaccess\node\config\project_node\ 

2. In this exercise, we will copy WAPlus.swf to 

 c:\webaccess\node\config\Training_20091215 

 

 

 

 

 

 

 

 

3. Right click the Mouse on DrawDAQ and select the project       

Video Display 
- Insert a Flash File - 



1. Dynamic -> Video Display, a “Video Display” dialog box will pop up. 

 

 

 

 

 

 

 

2. Enter a “Name” in Name text box and enter the 

“swflash#WAPlus.swf&play=true&loop=true&menu=true&popmenu=true” in 

Video text box 

 

 

 

 

 

 

 

3. Click OK button 

Video Display 
- Insert a Flash File - 



1. Dynamic -> Video Display, a “Video Display” dialog box will pop up. 

2. Setup “first corner” and “second corner” to define the size of Video Display. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Save the page to flash.bgr and flash.drw 

 

 

 

 

 

 

Video Display 
- Insert a Flash File - 



1. Download project 

 

 

 

 

 

 

 

 

2. Result 

 

 

 

 

 

 

Video Display 
- Insert a Flash File - 



ODBC 
 



1. WebAccess default ODBC is MS Access 

2. By using ODBC, LogData Maintenance must also setup 

 Data Maintenance supports data relocation save and deletion 

 These actions will make sure the database won’t explore 

3. The file is located under c:\webaccess\node\bwpdata.mdb 

 

ODBC 



1. Total nine tables in bwpdata.mdb, seven of them may be used for data exchange. 

2. “BwLogTagExt” and “BwLogTblInfo” are for RD internal use only. 

ODBC 
- MS Access BwPdata.mdb - 

Bwpdata.mdb WebAccess 

BwActionTable Action Log 

BwAlarmTable Alarm Log 

BwAnaChgLog Analog Change Log 

BwAnalogTable Analog Tag Log 

BwDiscreteTable Discrete Tag Log 

BwSysLogTable System Log 

BwTextTable Text Tag Log 



 By setting ODBC, LogData Maintenance must also setup 

 Data Maintenance supports data relocation save and deletion 

 These actions will make sure the database won’t explore 

 

ODBC 
- LogData Maintenance - 

data maintenance starts time 

Save data to other location 

Delete expired data 



1. Set “Data Log To ODBC” in SCADA Node property 

2. Data Log To ODBC: the data is stored at “Analog Tag Log” and “Discrete Tag Log” 

ODBC 



1. Setup “Log to ODBC Frequency” in Tag property 

ODBC 

1. After finishing setup SCADA Node and Tag properties, back to SCADA Node and 

click “Download” 



1. By clicking “Analog Tag Log”, user may query AO tag historical data from MS 

Access 

ODBC 

1. Result 



Report 
 



1. WebAccess supports three types of reports 

1. Shift Report 

2. Daily Report 

3. Monthly Report 

 

2. All reports retrieve data from central database (default database is MS Access) 

 

3. In here, we will practice “Daily Report” 

 

4. Click “Report” in SCADA Node 

Report 



1. Click “Add New Scheduled Report” 

Report 

1. Click “Add New Scheduled Report” 

• “Report Name” can’t have any space 

Tag name can be selected from Tag List 

Enter all necessary information 



1. Click “Enable” in Daily Report 

2. Click “Excel Out” if user prefers WebAccess to auto-generate report in midnight. 

• File name will be Project Node name bundled with date 

• Report will be generated to the below location 

• C:\webaccess\node\Training_20091215\Report\Traiing_20131225.xls 

3. Click “Advanced…” button for more detailed setup 

Report 

• Auto generate Daily Report in every midnight 

• Active Daily Report 



1. Each tag allows to enter four descriptions 

2. Click “Submit” when it is done. 

Report 

• Four descriptions 

1. Click “Submit” again to complete the Daily Report setup 



1. Click “View” to view the Daily Report 

Report 

2. Daily Report result 



Google Map Integration 



1. To active GoogleMap function, user’s computer must go online 

 

2. Google Map function is located in SCADA Node property 

 

3. Click “GoogleMap” to start it. 

Google Map Integration 



1. Google Map will appear on the screen. 

2. Two ways to select Google Map area: 

 First Way: Use Mouse to select area and location 

 Second Way: Enter Longitude and Latitude manually 

Google Map Integration 

Use Google Map tools 

or directly drag the Google Map 

First Way 

Second Way: 
Click left button of mouse to 

directly enter Title, Longitude, 

Latitude and Image  



Google Map Integration 

1. For first way: 

 After select the area, click right button of mouse to enter Title, Lng and Lat. 

2. For both first and second ways: 

 Click “Add” button to insert a flag 

Size limitation for uploading 

user’s own icon; 10KB 



1. GoogleMap allows user to display three tags with their values on the screen 

2. Click “OK” in Marker Information when setup is done. 

Google Map Integration 

Label: enter the name that user may recognize (ex. Temperature) 

Tagname: Tag Name (ex. A0) 



1. Click “Save” when all setup is completed. 

2. User will see a ‘Vancouver” marker on the screen 

Google Map Integration 

Vancouver marker 



1. Last, remember to save and download the GoogleMap. 

Google Map Integration 



1. GoogleMap is able to insert into Video Display 

1. Key word: uti:gmap/gmap.asp?hwnd=%HWND&map=Vancouver& 

Google Map Integration 

The name “Vancouver” is based 

on user’s GoogleMap file name 



1. Result 

Google Map Integration 



1. Google Map source files will be store at 

• C:\Inetpub\wwwroot\broadweb\gmap\ 

2. “Training_20091215” folder contains source files of WebAccess Training project 

Google Map Integration 



GPS Integration 
 

(available in WebAccess V7.2) 



 GPS function is based on Google Map function 

 Please compete GPS Integration before starting GPS Integration 

 

 Please refer to WebAccess Engineering User Manual 17.3.3.3 “WebAccess GPS 

Location Tracking Configuration” for detail setup steps. 

 

 Here only focus on GPS simulation, so you may demo GPS Integration function to 

other user without actually having a GPS module on hand. 

GPS Integration 



1. Copy test.ltg and gpsJs.js to c:\webaccess\node\config\Training_20091215\bgr 

 

      Note: these three files may be found in “training material” 

 

2. The purpose of having test.ltg is to create four local tags. And we willuse these four 

local tags to simulate four objects on Google Map. 

 

 

 

 

 

 

 

 

 

GPS Integration 



1. gpsJS.js script information 

      The purpose of gpsJS is to control four tags moving directions. 

 

GPS Integration 



1. Click “GoogleMap” function in SCADA Node 

 

 

 

 

 

2. Create 4 tags (ex. first tag will be: Title: airplane1; Tracking Tagname: text1) 

      click “Set As Default Tracking” if you prefer this tag to be displayed in the center of 

      the Google Map. 

GPS Integration 



1. Save and download project 

2. Use notepad.exe to open c:\webaccess\node\training_20091215 

 

 

 

3. Add “test.ltg” in tagfile 

4. Add “gpsJs.js” in run_name 

5. Add “50” in run_interval 

 

 

 

GPS Integration 



1. Check result: ViewDAQ -> Tools -> Map -> Vancouver.map 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: user has to re-modify Vancouver.map everytime user re-download the 

project. 

 

 

GPS Integration 



Dashboard 



1. Open WebAccess Project Home Page 

2. Go to Project Management and Login the Account 

 

Dashboard 



1. Choose the Project and go to Dashboard Edit 

 

 

Dashboard 



1. Create New Dashboard 

 

 

Dashboard 



1. Drag the Widget Library and Choose widget to edit the Dashboard page in 

Dashboard Area. 

 

 

Dashboard 



1. Widget Library dialog box will pop up. 

2. Drag and drop “Real-time Area Trend” and “Meter” widgets one by one. 

 

 

Dashboard 



1. Config the page with the right pane Properties 

2. Setup Time Interval in “Widget Setting” 

3. Select the IO tag in “ WebAccess Data Source” 

4. Click “APPLY” button when these steps are done. 

 

Dashboard 



1. Save the Dashboard page 

2. “Save Dashboard” dialog box will pop up 

3. Enter file name and click “Save” button 

 

 

Dashboard 



1. Go to dashboard Viewer to view the result 

 

 

Dashboard 



1. Result in Dashboard View 

 

 

Dashboard 



Excel Report 



1. Start Advantech WebAccess Project Manager. 

2. Login with the User Name and Password and select your Project Name. 

3. Open the SCADA node. 

4. Choose the EXCEL Report in SCADA Node：Go to the EXCEL report list page 

 

 

 

Excel Report 



1. Click New Report to create NEW EXCEL report 

 

 

Excel Report 



1. Configure the Report information 

2. Enter Report Name 

3. Select “self-defined” in Report Type, then setup range in “Start” and “End” 

4. Setup “Time Interval” and “Time Unit”. Here use 10 minutes as an example 

5. Select Data Type and tag(s) 

 

Excel Report 



1. Click “Submit” button to save the configuration 

 

 

Excel Report 



1. Clicking Generate to generate the Report. If the report has been generated, the 

report link is shown in the View column 

 

 

 

 

 

 

 

 

 

2. Excel Report result: 

 

 

Excel Report 



THANK YOU!  


